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1. Related Manuals 
 

The table below lists the manuals related to this document.  

To ensure system safety, make sure to always read and heed the information provided in all 

Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device which is used in the system.  

 

Cat. No.  Model Manual name 

W500 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Hardware User's Manual 

W501 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Software User's Manual 

W506 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Built-in EtherNet/IPTM Port User's 

Manual 

W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation Manual 

ME0313 XSEL-R/S/RX/SX/RXD/SXD XSEL Controller R/S/ RX/SX/RXD/SXD Type 

Operation Manual 

ME0308 XSEL-R/S/RX/SX/RXD/SXD EtherNet/IP Operation Manual  

XSEL-R/S/ RX/SX/RXD/SXD 

ME0154 IA-101-X-MW 

IA-101-X-MW-J 

IA-101-XA-MW 

IA-101-X-USB 

IA-101-X-USBMW 

PC Software for X-SEL 

Operation Manual 
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2. Terms and Definitions 
 

Term Explanation and Definition 

Node Controllers and devices are connected to the EtherNet/IP network via the 

EtherNet/IP ports. The EtherNet/IP recognizes each EtherNet/IP port 

connected to the network as one node.  

When a device with two EtherNet/IP ports is connected to the 

EtherNet/IP network, the EtherNet/IP recognizes this device as two 

nodes.  

The EtherNet/IP achieves the communications between controllers or the 

communications between controllers and devices by exchanging data 

between these nodes connected to the network.  

Tag A minimum unit of the data that is exchanged on the EtherNet/IP network 

is called a tag. The tag is defined as a network variable or as a physical 

address, and it is allocated to the memory area of each device.  

Tag set In the EtherNet/IP network, a data unit that consists of two or more tags 

can be exchanged. The data unit consisting of two or more tags for the 

data exchange is called a tag set. Up to eight tags can be configured per 

tag set for OMRON controllers.  

Tag data link In the EtherNet/IP, the tag and tag set can be exchanged cyclically 

between nodes without using the user program. This standard feature on 

the EtherNet/IP is called a tag data link.  

Connection A connection is used to exchange data as a unit within which data 

concurrency is maintained. The connection consists of tags or tag sets. 

Creating the concurrent tag data link between the specified nodes is 

called a "connection establishment ". When the connection is 

established, the tags or tag sets that configure the connection are 

exchanged between the specified nodes concurrently. 

Originator and 

Target 

To perform tag data links, one node requests the opening of a 

communications line called a "connection".  

The node that requests opening the connection is called a "originator", 

and the node that receives the request is called a "target" 

Tag data link 

parameter 

The tag data link parameter is the setting data to perform the tag data 

link. It includes the data to set tags, tag sets, and connections.  

EDS file A file that describes the number of I/O points for the EtherNet/IP device 

and the parameters that can be set via EtherNet/IP. 
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3. Precautions 
 

(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 

circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, always read and heed the information provided in all Safety 

Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 

conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 

document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of July 2013. It is subject to 

change without notice for improvement.  

 

The following notation is used in this document. 

 

Indicates a potentially hazardous situation which, if not avoided, 
will result in minor or moderate injury, or may result in serious 
injury or death.Additionally there may be significant property 
damage. 

 

Precautions for Safe Use 

Precautions on what to do and what not to do to ensure safe usage of the product. 

 

Precautions for Correct Use  

Precautions on what to do and what not to do to ensure proper operation and performance. 

 

Additional Information  

Additional information to read as required. 
This information is provided to increase understanding or make operation easier. 

 
Symbols 
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4. Overview 
 

This document describes the procedure for connecting X-SEL Controller 

(XSEL-R/S/RX/SX/RXD/SXD) manufactured by IAI Corporation (hereinafter referred to as 

IAI ) with NJ-series Machine Automation Controller (hereinafter referred to as the Controller) 

manufactured by OMRON Corporation (hereinafter referred to as OMRON) via EtherNet/IP, 

and describes the procedure for checking their connection. 

It also contains the procedure for performing EtherNet/IP tag data link using the EtherNet/IP 

settings of the project file that is prepared beforehand (hereinafter referred to as the 

"procedure for using the configuration files"). 

Section 9 Appendix 1 and Section 10 Appendix 2 describe the procedures for setting 

parameters with software without using files (hereinafter referred to as the "procedure for 

setting parameters from beginning". 

 

To follow the "procedure for using configuration files", obtain the latest "Sysmac Studio project 

file" and "Network Configurator v3 network configuration file" (they are referred to as 

"configuration files") from OMRON in advance.  

 

Name File name Version 
Sysmac Studio project file 
(extension: smc) 

IAI_X-SEL_EIP_EV100.smc Ver.1.00 

Network Configurator v3 network 
configuration (extension: nvf) 

IAI_X-SEL_EIP_EV100.nvf Ver.1.00 
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 

The applicable devices are as follows.  

 

Manufacturer Name Model 
OMRON NJ-series CPU Unit NJ501-[][][][] 

NJ301-[][][][] 
IAI X-SEL Controller XSEL-R-[]-EP-[] 

XSEL-S-[]-EP-[] 
XSEL-RX-[]-EP-[] 
XSEL-SX-[]-EP-[] 
XSEL-RXD-[]-EP-[] 
XSEL-SXD-[]-EP-[] 

IAI Actuator - 

 

Precautions for Correct Use  

As applicable devices above, the devices with the models and versions listed in Section 5.2. 

are actually used in this document to describe the procedure for connecting devices and 

checking the connection.  

You cannot use devices with versions lower than the versions listed in Section 5.2.  

To use the above devices with versions not listed in Section 5.2 or versions higher than those 

listed in Section 5.2, check the differences in the specifications by referring to the manuals 

before operating the devices.  

 

Additional Information  
This document describes the procedure to establish the network connection. Except for the 

connection procedure, it does not provide information on operation, installation or wiring 

method. It also does not describe the functionality or operation of the devices. Refer to the 

manuals or contact the device manufacturer.  

(IAI Corporation  http://www.intelligentactuator.com/) 

This URL is the latest address at the time of this document creation. Contact each device 

manufacturer for the latest information.  

 

Additional Information  
Contact the device manufacturer for actuators connectable to X-SEL Controllers.  

(IAI Corporation  http://www.intelligentactuator.com/) 

 

http://www.intelligentactuator.com/�
http://www.intelligentactuator.com/�
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5.2. Device Configuration 

The hardware components to reproduce the connection procedure of this document are as 

follows.  

 

 

 

 

 

 

 

 

 

 
Manufacturer Name Model Version 

OMRON NJ-series CPU Unit 
(Built-in EtherNet/IP port) 

NJ501-1500 Ver.1.05 

OMRON Power Supply Unit NJ-PA3001  
OMRON Switching Hub W4S1-05C Ver.1.00 
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.06 
OMRON Network-Configurator (Included in Sysmac 

Studio.) 
Ver.3.55 

OMRON Sysmac Studio project file IAI_X-SEL_EIP_EV100.smc Ver.1.00 
OMRON Network Configurator v3 

network configuration file 
IAI_X-SEL_EIP_EV100.nvf Ver.1.00 

- Personal computer (OS: 
Windows7) 

-  

- USB cable 
(USB 2.0 type B connector) 

-  

- LAN cable (STP (shielded, 
twisted-pair) cable of Ethernet 
category 5 or higher) 

-  

IAI X-SEL Controller XSEL-R-[]-EP-[] Ver.1.04 

IAI Single-axis robot ISB-SXM-I-60-4-500-T1-S-B  

IAI EDS file 368-9523-EDS_ABCC_EIP
_V_2_2.eds 

Ver.2.2 

IAI PC Interface Software for 

X-SEL 

IA-101-X-USBMW V9.00.00.0

0E 
IAI RS232C cable + Emergency 

Stop Box 

CB-ST-E1MW050-EB *1  

IAI USB cable - *1  

IAI USB conversion adapter - *1  

* 1: Included in PC Interface Software for X-SEL. 

USB cable 

LAN cable 
NJ501-1500 
(Built-in EtherNet/IP port) 

Switching Hub 
W4S1-05C 

Personal computer (Sysmac Studio, 
PC Interface Software for X-SEL 
installed, 
OS:Windows 7) 

RS232C cable + Emergency Stop Box Single-axis robot 

X-SEL Controller 

 

USB cable  
USB conversion 
adapter  
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Precautions for Correct Use  

Prepare the corresponding EDS file beforehand. The latest EDS file can be downloaded from 

IAI website http://www.intelligentactuator.com/field-network-configuration-files/ 

Contact IAI Corporation if the file is not available. 

 

Precautions for Correct Use  

When there is an icon file specific to the device, the icon file and the EDS file must be stored 

in the same folder.  

 

Precautions for Correct Use  

Prepare the latest "Sysmac Studio project file" and "Network Configurator v3 network 

configuration file" from OMRON in advance.  

(To obtain the files, contact your OMRON representative.) 

 

Precautions for Correct Use  

Update the Sysmac Studio to the version specified in this section or higher version using the 

auto update function.  

If a version not specified in this section is used, the procedures described in Section 7 and 

subsequent sections may not be applicable. In that case, use the equivalent procedures 

described in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) and Network 

Configurator Online Help. 

 

Additional Information  
The system configuration in this document uses USB for the connection to the Controller. For 

information on how to install a USB driver, refer to A-1 Driver Installation for Direct USB Cable 

Connection of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

 

Additional Information  
The system configuration in this document uses a USB conversion adapter for the connection 

between the personal computer and X-SEL Controller. For information on how to install a 

USB conversion adapter driver, refer to 1.3.2 How to Install the USB Conversion Adapter 

Driver Software of the PC Software for X-SEL Operation Manual (Cat.No.ME0154).  

 

http://www.intelligentactuator.com/field-network-configuration-files/�
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6. EtherNet/IP Settings 
 

This section describes the specifications such as communication parameters and tag data link 

that are defined in this document. 

Hereinafter, the X-SEL Controller is referred to as the "destination device" in some 

descriptions. 
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6.1. EtherNet/IP Communications Parameters 

The communications parameters required to connect the Controller and the destination device 

via EtherNet/IP are given below.  

In this document, each 128 I/O points from the beginning of the Standard I/O port are 

allocated to the EtherNet/IP board (Network I/F Module 1) of the X-SEL Controller. The other 

I/O boards (e.g. I/O board or Network I/F Module 2) are not used in this setting. 

 

 Controller 

Mode (node 1)

X-SEL Controller (node 2) 

IP address 192.168.250.1 192.168.250.2 

Subnet mask 255.255.255.0 255.255.255.0 
Baud rate - 0 (Autonegotiation) 
I/O Port Allocation Type - 0*1 (Fixed Allocation)  
 Standard I/O (I/O board, I/O slot 1 and 2)  
 Input Port Start No. in Network 

I/F  
- -1 (Not valid) 

 Output Port Start No. in Network 
I/F  

- -1 (Not valid) 

 Error Monitor  - 0 (Do not monitor: I/O board is 
not used) 

 Network I/F Module 1 
 No. of Remote Input Ports - 128* 2 (16 byte) 
 No. of Remote Output Ports - 128* 2 (16 byte) 
 Input Port Start No. in Network 

I/F.  
- 0* 3 

 Output Port Start No. in Network 
I/F.  

- 300* 4 

 Error Monitor - 1 (Monitor: Network I/F Module 
1 is used) 

 Network I/F Module 2 
 No. of Remote Input Ports - 0 
 No. of Remote Output Ports - 0 
 Input Port Start No. in Network 

I/F.  
- -1 

 Output Port Start No. in Network 
I/F.  

- -1 

 Error Monitor - 0 (Do not monitor: Network I/F 
Module 2 is not used) 

* 1: In this document, I/O Port Allocation Type is set to the Fixed Allocation to enable 

the setting of "Input Port Start No. in Network I/F" and "Output Port Start No. in 

Network I/F" for "Network I/F Module 1". 

* 2: The No. of Ports is set in 8-port units. The setting range is 0 to 256. 

* 3: The Input Port Start No. is either 0+(multiple of 8) or 1000+ (multiple of 8). Invalid 

if -1 is set. The setting range is -1 to 299, and 1000 to 3999. 

* 4: Output Port Start No. is either 300+(multiple of 8) or 4000+(multiple of 8). Invalid 

if -1 is set. The setting range is -1, 300 to 599, and 4000 to 6999. 
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6.2. Allocating the Tag Data Links  

The data in the tag data links of the destination device are allocated to the global variables of 

the Controller. The relationship between the device data and the global variables is shown 

below. The following global variables are defined in the "Configuration file". 

 

■Output area (Controller → SEL Controller) 

Offset Destination device data Global variable Data type

+0 to +7 Input port (Port No. 0 to 127) EIP002_Data_OUT WORD[8]

<Detailed allocation > 

Assigned Bit Port No. Function name 
0 000 Program start 

1 to 6 001 to 006 Universal input 

7 to 13 007 to 013

Program specification (indicate 
startup program number with in 
binary) 
007(LSB) to 013(MSB) 

EIP002_Data_OUT[0] 

14 to 15 014 to 015 Universal input 
EIP002_Data_OUT[1] 0 to 15 016 to 031 Universal input 

: : : : 
EIP002_Data_OUT[7] 0 to 15 112 to 127 Universal input 

 

■Input area (Controller ←X-SEL Controller) 

Offset Destination device data Global variable Data type

+0 to +7 Output port (port No.300 to 427) EIP002_Data_IN WORD[8] 

<Detailed allocation > 

Assigned Bit Port No. Function name 
0 300 Alarm output  
1 301 Ready output  
2 302 Emergency stop output 

EIP002_Data_IN[0] 

3 to 15 303 to 315 Universal output 
EIP002_Data_IN[1] 0 to 15 316 to 331 Universal output 

: : : : 

EIP002_Data_IN[7] 0 to 15 412 to 427 Universal output 
 

Additional Information  
For the details of the I/O formats for X-SEL Controllers, refer to 3.7 Standard I/O Ports of 
XSEL Controller and 3.8 I/O Port and Data Reading and Writing of the EtherNet/IP Operation 
Manual XSEL-R/S/ RX/SX/RXD/SXD (Cat.No.ME0308). 

 

Additional Information  
With the Sysmac Studio, two methods can be used to specify an array for a data type. After 
specifying, (1) is converted to (2) and the data type is always displayed as (2).  

(1) WORD[3]/ (2) ARRAY[0..2] OF WORD 
In this document, the data type is simplified by displaying WORD[3].  
(The example above means a WORD data type with three array elements.) 
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Personal computer 

Destination 

device 

Controller 

 

7. EtherNet/IP Connection Procedure  
 

This section describes the procedure for connecting the X-SEL Controller to the Controller via 

EtherNet/IP using the "procedures for using configuration files". 

This document explains the procedures for setting up the Controller and the X-SEL Controller 

from the factory default setting. For the initialization, refer to Section 8 Initialization Method.  

 

■Setting Overview 

The following figure shows the relationship between the processes to operate the 

EtherNet/IP tag data link using the "procedure for using configuration files". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Precautions for Correct Use  

Prepare the latest "Sysmac Studio project file" and "Network Configurator v3 network 

configuration file" from OMRON in advance. 

(To obtain the files, contact your OMRON representative.) 

 

Transferring the 
Project Data 

Importing the 
Project File 

Installing EDS 
file 

Transferring the 
Tag Data Link 
Parameters

Opening the Network 
Configuration File 

Sysmac Studio  
project file 

EDS file 

" Network Configurator v3 
network configuration file " 

Configuration file 

 

Network Configurator Sysmac Studio 
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7.1. Work Flow 

Take the following steps to operate the tag data link for EtherNet/IP.  

 

7.2. Setting Up the IAI X-SEL Controller Set up the IAI X-SEL Controller. 

 ↓   
 7.2.1. Parameter Settings Set the parameters for the X-SEL Controller. 

↓  

7.3. Setting Up the Controller Set up the Controller.  

↓  
 7.3.1. Starting the Sysmac Studio and 

Importing the Project File 

Start the Sysmac Studio and import the Sysmac 
Studio project file.  

↓  
 7.3.2. Connecting Online and 

Transferring the Project Data 

Connect online with the Sysmac Studio and 
transfer the project data to the Controller.  

↓  

7.4. Setting Up the Network Set the tag data links for the EtherNet/IP.  

↓  
 7.4.1. Starting the Network 

Configurator and Installing the 

EDS File 

Start the Network Configurator and install the 
EDS file.  

↓  
 7.4.2. Opening the Network 

Configuration File and 

Connecting Online 

Open the Network Configurator v3 network 
configuration file and connect online with the 
Controller.  

↓  
 7.4.3. Transferring the Tag Data Link 

Parameters 

Transfer the tag data link parameters to the 
Controller.  

↓  

7.5. Checking the EtherNet/IP 

Communications 

Confirm that the EtherNet/IP tag data links are 
performed normally. 

↓  
 7.5.1 Checking the Connection Status Check the connection status of EtherNet/IP.  

↓  
 7.5.2 Checking the Data that are Sent 

and Received 

Confirm that the correct data are sent and 
received.  
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7.2. Setting Up the IAI X-SEL Controller 

Set up IAI X-SEL Controller 

 

7.2.1. Parameter Settings 
Set the parameters for the X-SEL Controller.  

Parameters are set by "PC Interface Software for X-SEL". Install the corresponding 

software and USB Driver to the personal computer beforehand. 

 

1 Connect the X-SEL Controller to 

the switching Hub with a LAN 

cable. 

* Connect the LAN cable to the 

EtherNet communications 

connector of the X-SEL 

Controller. 

 

Connect the X-SEL Controller to 

the USB cable + USB 

conversion adapter with a 

RS-232C cable. 

* Connect the RS-232C cable to 

the Teaching connector of the 

X-SEL Controller.  

 

 

 

 

2 Set the MODE switch on the 

front of the X-SEL Controller to 

the MANU side.  
 

3 Turn ON the power supply to the 

X-SEL Controller. 

 

4 Start the PC Interface Software 

for X-SEL from the personal 

computer. 

 

Teaching connector 
Mode switch 

EtherNet communications connector 

AC power supply input connector 
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5 When the software starts, the 

Connection Confirmation Dialog 

Box is displayed. 

Select the communications port 

No. that is connected to the 

communication port and click 

the OK Button. 

 

* If there are multiple serial ports 

on the personal computer, 

display the Windows Device 

Manager and select the same 

port as the communications 

port No. that the X-SEL 

Controller is connected 

(COM1 in this example) 

shown under the Ports (COM 

& LPT).  

 

* To display the Device 

Manager, right-click the 

Computer and select 

Properties - Device 

Manager.  

 

6 The Setting of Two or more 

programs start Dialog Box on 

the right is displayed. Click the 

OK Button. 

7 The PC Interface Software for 

X-SEL starts. 
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8 Select Edit from the Parameter 

Menu.  

 

9 The Edit Parameter Dialog Box 

is displayed. Set the parameters 

of No.1 to No.5, No.10 and 

No.11, and No.14 to No.18 as 

shown below.  

No1: 0 

No2: -1 

No3: -1 

No4: -1 

No5: -1 

No10: 0 

No11: 0 

No14: 128 

No15: 128 

No16: 0 

No17: 300 

No18: 1 

* No need to change other 

parameters shown on the 

right. 

10 Set the parameters of No.132 to 

No.139 on the Edit Parameter 

Dialog Box as shown below.  

No132: 192 

No133: 168 

No134: 250 

No135: 2 

No136: 255 

No137: 255 

No138: 255 

No139: 0 
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11 Set the parameters of No.227 to 

No.235 on the Edit Parameter 

Dialog Box as shown below.  

No227: 0 

No231: 0 

No232: 0 

No233: -1 

No234: -1 

No235: 0 

* No need to change other 

parameters shown on the 

right.  

* If Network I/F Module 1 is 

EtherNet/IP, "7h" is displayed 

in the No.225 Column. 

12 After setting the parameters, 

click the  icon to transfer it 

to the Controller. 

 

A Confirmation Dialog Box is 

displayed as shown on the right. 

Check the contents and click the 

Yes Button. 

  

* If no change is made to the 

parameter setting value, the 

dialog boxes shown after this 

step is not displayed. Proceed 

to step 16. 

 

 

 

 

13 The dialog box on the right is 

displayed. Check the contents 

and click the OK Button.  
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14 The dialog box on the right is 

displayed. Select the Parameter 

Check Box and click the Yes 

Button.  

15 A dialog box on the right is 

displayed. Check the contents 

and click the Yes Button.  

 
16 When the X-SEL Controller 

starts, the dialog box on the right 

is displayed. 

 

17 When the X-SEL Controller is 

reconnected to the personal 

computer, the dialog box on the 

right disappears. 

 

Confirm that the X-SEL 

Controller is successfully 

reconnected to the personal 

computer, and then exit the PC 

Interface Software for X-SEL. 
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7.3. Setting Up the Controller 

Set up the Controller.  

 

7.3.1. Starting the Sysmac Studio and Importing the Project File 
Start the Sysmac Studio and import the Sysmac Studio project file.  

Install the Sysmac Studio and USB driver in the personal computer beforehand.  

 

1 Connect the LAN cable to the 

built-in EtherNet/IP port 

(PORT1) of the Controller and 

the USB cable to the peripheral 

(USB) port. Then connect the 

Controller, personal computer, 

and switching hub by referring to 

5.2. Device Configuration. 

Turn ON the power supply to the 

Controller.  

 

2 Start the Sysmac Studio.  

Click the Import Button.  

 

* If a confirmation dialog box for 

an access right is displayed at 

start, select to start.  

 

 

3 The Import File Dialog Box is 

displayed. Select 

IAI_X-SEL_EIP_EV100.smc 

(Sysmac Studio project file) and 

click the Open Button.  

 

* Obtain the Sysmac Studio 

project file from OMRON.  

 

USB cable 

CPU Unit

End cover

Power Supply Unit

LAN cable 

Switching hub

Controller 
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4 The IAI_X-SEL_EIP_EV100 is 

displayed. 

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

 

* If an error message is 

displayed stating "Failed to 

Load Descendants", change 

the version of the Sysmac 

Studio to the version specified 

in 5.2. Device Configuration or 

higher version.  

 

 

5 Select Check All Programs 

from the Project Menu.  

 

6 The Build Tab Page is displayed 

in the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

 

7 Select Rebuild Controller from 

the Project Menu.  

 

8 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

9 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  

 

Multiview 
Explorer 

Edit Pane Toolbox 
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7.3.2. Connecting Online and Transferring the Project Data 
Connect online with the Sysmac Studio and transfer the project data to the Controller.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

1 Select Change Device from the 

Controller Menu.  

 

2 The Change Device Dialog Box 

is displayed.  

Confirm that Device and Version 

to use are set as shown on the 

right.  

 

* If the settings are not correct, 

select the setting items from 

the pull-down list.  

 

Click the OK Button.   

3 If the settings were changed in 

step 2, the Build Dialog Box is 

displayed. Check the contents 

and click the Yes Button.  

 

4 Select Communications Setup 
from the Controller Menu.  
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5 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option for Connection 

Type.  

 

Click the OK Button.  

6 Select Online from the 

Controller Menu.  

 

 

 

* If the dialog box on the right is 

displayed, the model or 

version of the Controller does 

not match that of the project 

file. Match the Controller 

model and version by 

changing the device settings 

of the project file, and then 

repeat the procedure from 

step 1 in this section. Close 

the dialog box by clicking the 

OK Button.  

 

* The model and version 

displayed on the confirmation 

dialog box differ depending on 

the Controller used and the 

device setting of the project 

file.  

 

 
 
* Example of confirmation dialog box 
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Additional Information  
For details on online connections to a Controller, refer to Section 5 Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

7 A confirmation dialog box is 

displayed as shown on the right. 

Confirm that there is no problem 

and click the Yes Button.  

 

* The displayed dialog box 

depends on the status of the 

Controller used. Click the Yes 

Button to proceed with the 

processing.  

 

* The displayed serial ID differs 

depending on the device.  

 

 

8 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  

9 Select Synchronization from 

the Controller Menu.  
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10 The Synchronization Dialog Box 

is displayed.  

Confirm that the data to transfer 

(NJ501 in the right dialog box) is 

selected. Then, click the 

Transfer To Controller Button. 

 
* After executing the Transfer To 

Controller, the Sysmac Studio 
data is transferred to the 
Controller and the data are 
compared.  

 

 

11 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

 

 

A screen stating "Synchronizing" 

is displayed.  

 

 

A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the No 

Button.  

* Be sure not to return it to "RUN 

mode".  

 

 



7．EtherNet/IP Connection Procedure 

 24

12 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized" 

and that a message is displayed 

stating "The synchronization 

process successfully finished" 

If there is no problem, click the 

Close Button.  

 

* A message stating "The 

synchronization process 

successfully finished" is 

displayed if the Sysmac Studio 

project data and the data in 

the Controller match.  

 

* If the synchronization fails, 

check the wiring and repeat 

from step 1.  
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7.4. Setting Up the Network 

Set the tag data links for the EtherNet/IP.  

 

7.4.1. Starting the Network Configurator and Installing the EDS File 
Start the Network Configurator and install the EDS file.  

 

1 Start the Network 

Configurator.  

2 Select Install from the EDS File 

Menu.  

 

3 Select the 

368-9523-EDS_ABCC_EIP_V_

2_2.eds as an EDS file to install 

and click the Open Button.  

 

* For how to obtain the EDS file, 

refer to Precautions for 

Correct Use in 5.2. Device 

Configuration.  

 

Network window 
Hardware 
List 
Window 
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4 The dialog box on the right is 

displayed. Check the contents 

and click the No Button.  

 

5 When the EDS file is normally 

installed, the device is added as 

shown in the right figure.  

Confirm that the device was 

added to the EtherNet/IP 

Hardware List.  

 

* When the 

368-9523-EDS_ABCC_EIP_V

_2_2.eds is installed, 

Anybus-CC EtherNet/IP 

device is registered. 

 

 

 

 

 

Precautions for Correct Use  

Please confirm that the LAN cable is connected before performing the following procedure.  

When it is not connected, turn OFF the power supply to each device and then connect the 

LAN cable.  
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7.4.2. Opening the Network Configuration File and Connecting Online 
Open the Network Configurator v3 network configuration file and connect online with the 

Controller.  

 

1 Select Open from the File Menu. 

 

2 The Open Dialog Box is 

displayed. Select 

IAI_X-SEL_EIP_EV100.nvf 

(Network Configurator v3 

network configuration file) and 

click the Open Button.  

 

* Obtain the Network 

Configurator v3 network 

configuration file from 

OMRON.  

 

3 The following devices are 

displayed in the Network 

Configuration Pane as shown in 

the right figure.  

IP address of node 1: 

192.168.250.1 

IP address of node 2: 

192.168.250.2 

 

* The X-SEL Controller icon 

changes to the Anybus-CC 

EtherNet/IP device. 

 

 

 

4 Select Select Interface - NJ 

Series USB Port from the 

Option Menu. 

5 Select Connect from the 

Network Menu.  
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6 The Select Connect Network 

Port Dialog Box is displayed. 

Select TCP:2. 

Click the OK Button.  

7 The Select Connected Network 

Dialog Box is displayed. Check 

the contents and click the OK 

Button. 

8 When an online connection is 

established normally, the color 

of the icon on the right figure 

changes to blue.  

 

 

 

Additional Information  
If an online connection cannot be made to the Controller, check the cable connection. Or, 

return to step 4, check the settings and repeat each step.  

For details, refer to 7.2.8 Connecting the Network Configurator to the Network in Section 7 

Tag Data Link Functions of the NJ-series CPU Unit Built-in EtherNet/IP Port User's Manual 

(Cat. No. W506).   

 



7．EtherNet/IP Connection Procedure 

 29

 

7.4.3. Transferring the Tag Data Link Parameters 
Transfer the tag data link parameters to the Controller.  

 

1 Right-click node 1 device on the 

Network Configuration Pane and 

select Parameter - Download. 

 

 

 

 

 

 

 

The dialog box on the right is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

2 Tag data link parameters are 

downloaded from the Network 

Configurator to the Controller.  

 

3 The dialog box on the right is 

displayed. Check the contents 

and click the OK Button.  
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7.5. Checking the EtherNet/IP Communications 

Confirm that the EtherNet/IP tag data links are operated normally. 

 

7.5.1. Checking the Connection Status 
Check the connection status of EtherNet/IP.  

 

1 Confirm that the tag data links are 

normally in operation by checking 

the LED indicators on each device. 

 

・LED indicators on the Controller 

(Built-in EtherNet/IP port) in normal 

status are as follows:  

[NET RUN]: Lit green 

[NET ERR]: Not lit 

[LINK/ACT]: Flashing yellow 

(Flashing while packets are being 

sent and received) 

 

 

 

・LED indicators on the X-SEL 

Controller in normal status are as 

follows: 

[MS]: Lit green 

[NS]: Lit green 

 

 

 

 

 

(Controller) 

 

(X-SEL Controller) 

2 Confirm that the tag data links are 

normally in operation by checking 

the status information on the Device 

Monitor Window of the Network 

Configurator.  

 

Right-click the device icon of node 1 

on the Network Configuration Pane 

and select Monitor.  
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3 The dialog box on the right displays 

the Status 1 Tab Page of the Device 

Monitor Dialog Box.  

 

When the same items in the right 

dialog box are selected, the data 

links are normally in operation.  

 

Click the Close Button.  

4 Select Disconnect from the 

Network Menu to go offline. The 

color of the icon on the figure 

changes from blue.  

Select Exit from the File Menu to 

exit the Network Configurator.  

 

 

Number:Node number 

Blue:Connection normal 
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7.5.2. Checking the Data that are Sent and Received 
Confirm that the correct data are sent and received.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch1 Tab Page is displayed 

in the lower section of the Edit 

Pane.  

 

 

3 The following names are entered in 

the Watch1 Tab Page for 

monitoring.  

EIP002_Data_OUT[0] 

EIP002_Data_OUT[1] 

EIP002_Data_OUT[2] 

EIP002_Data_IN[0] 

EIP002_Data_IN[1] 

EIP002_Data_IN[2] 

 

 

4  Enter 8421 in the Modify Column of 

EIP002_Data_OUT[0]. 

 

 

 

 

The Online value of 

EIP002_Data_OUT[0] changes to 

8421.  
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5 Start the PC Interface Software for 

X-SEL. 

 

* For information on how to start a 

PC Interface Software for X-SEL, 

refer to step 3 of 7.2.1. Parameter 

Settings.  

6 Select Input Port from the Monitor 

Menu. 

 

7 The Input Port Window is displayed, 

click the [16](Hex) on the Cardinal 

num Button. 

8 The value is displayed in 

hexadecimal. 

Confirm that the value of No.0000 is 

8421. 

 

Close the Input Port Window. 
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9 Select Output Port from the Monitor 

Menu. 

 

10 The Output Port Window is 

displayed. 

Confirm that the value of No.0300. 

* 0004 is displayed in the right 

figure. 

 

Close the Output Port Window. 

 

 

11 Confirm that the online value of 

EIP002_Data_IN[0] is the same 

value displayed in step 10. 
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8. Initialization Method 
 

This document explains the setting procedure from the factory default setting.  

Some settings may not be applicable as described in this document unless you use the 

devices with the factory default setting.  

 

8.1. Initializing the Controller 

To initialize the settings of the Controller, the CPU Unit and EtherNet/IP port need to be 

initialized. Place in PROGRAM Mode before the initialization.  

 

8.1.1. EtherNet/IP port 
Delete the connection information and tag information that are set for the EtherNet/IP port. 

Follow the procedure below to set blank connection information and blank tag information 

and delete them using the Network Configurator.  

 

(1) Deleting connection information 

In the Connections Tab Page of the Edit Device Parameters Dialog Box, move all devices 

registered in the Register Device List to the Unregister Device List.  

If a confirmation dialog box is displayed when you remove devices from the registration list, 

click the Yes Button.  

  

 

No registered 

devices 
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(2) Deleting tag information 

In the Tag Sets Tab Page of the Edit Parameters Dialog Box, click the Delete all of unused 

Tag Sets Button.  

If a confirmation dialog box is displayed when deleting, click the Yes Button.  

 
 

 

(3) Download 

Right-click the Controller and select Parameter - Download from the menu that is 

displayed.  

 
 

No registered 

tags 
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8.1.2. CPU Unit 
To initialize the settings of the CPU Unit, select Clear All Memory from the Controller 

Menu of the Sysmac Studio. The Clear All Memory Dialog Box is displayed. Check the 

contents and click the OK Button.  

 

 

 

 

8.2. Initializing the IAI X-SEL Controller 

For the initialization of the IAI X-SEL Controllers, refer to 8.4 How to Initialize XSEL-R/S, 

RX/SX, RXD/SXD, SSEL/ASEL/PSEL Parameters (at the time of shipment) of the PC 

Software for X-SEL Operation Manual (Cat.No.ME0154). 
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9. Appendix 1 Detailed Settings of the Tag Data Links
 

This section provides the detailed settings necessary to perform tag data links which are set in 

this document.  

 

 

9.1. Global Variable Table 

The Controller accesses the data in tag data links as global variables. The following are the 

settings of the global variables. Use the Sysmac Studio to register a global variable table.  

 

Name Data type 
Network 
publish 

Destination device allocation 

EIP002_Data_OUT WORD[8] Output Input port (port No.0 to 127) 

EIP002_Data_IN WORD[8] Input Output port (port No.300 to 427) 

 

Additional Information  
For the details of the I/O formats for X-SEL Controllers, refer to 3.7 Standard I/O Ports of 

XSEL Controller and 3.8 I/O Port and Data Reading and Writing of the EtherNet/IP Operation 

Manual (Cat.No.ME0308). 

 

Additional Information  
With the Sysmac Studio, two methods can be used to specify an array for a data type. After 

specifying, (1) is converted to (2) and the data type is always displayed as (2).  

(1) WORD[3] / (2) ARRAY[0..2] OF WORD 

In this document, the data type is simplified by displaying WORD[3].  

(The example above means a WORD data type with three array elements.) 
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9.2. Relationship between Destination Device and Global Variables 

Global variables need to be arranged in offset order of the destination device before setting 

the tag data link parameters. 

The relationship between the memory allocation of the destination device and the global 

variables is shown below. 

 

■Output area (Controller → X-SEL Controller) 

Offset Destination device data Global variable Data type

+0 to +7 Input port (port No.0 to 127) EIP002_Data_OUT WORD[8]

<Detailed allocation > 

Assigned Bit Port No. Function name 

0 000 Program start 

1 to 6 001 to 006 Universal input 

7 to 13 007 to 013

Program specification (indicate 
startup program number with in 
binary) 
007(LSB) to 013(MSB) 

EIP002_Data_OUT[0] 

14 to 15 014 to 015 Universal input 

EIP002_Data_OUT[1] 0 to 15 016 to 031 Universal input 

: : : : 

EIP002_Data_OUT[7] 0 to 15 112 to 127 Universal input 

 

■Input area (Controller ← X-SEL Controller) 

Offset Destination device data Global variable Data type

+0 to +7 Output port (port No.300 to 427) EIP002_Data_IN WORD[8]

<Detailed allocation > 

Assigned Bit Port No. Function name 

0 300 Alarm output 

1 301 Ready output 

2 302 Emergency stop output 
EIP002_Data_IN[0] 

3 to 15 303 to 315 Universal output 

EIP002_Data_IN[1] 0 to 15 316 to 331 Universal output 

: : : : 

EIP002_Data_IN[7] 0 to 15 412 to 427 Universal output 
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9.3. Associating the Tag Data Links 

Tag data link parameters are required to perform tag data links with a destination device.  

Follow the procedures below to associate the tag data links.  

(1) Use the Sysmac Studio to define the global variables to publish on the network.  

Store the created global variables in a CSV file to use in the Network Configurator.  

(2) Read the CSV file (tag list) created in step 1 to the Network Configurator.  

(3) Install the EDS file for the destination device in the Network Configurator.  

(4) Make a single tag set that includes the tag lists.  

(5) Link the tag set with the destination device information and create tag data link 

parameters.  

 

The numbers shown in the tables below correspond to the steps above.  

■Output area (Controller → SEL Controller) 
Controller setting 
(Set with Sysmac Studio) 

Tag data link parameter setting  
(Set with Network Configurator) 

Destination device 
information (EDS file 
setting contents) 

 
(1) 

 
Tag set: 
EIP002_OUT 

16 byte 
(5) 

←
(3) 

Output_150-[16 
Byte] 

Global variable  (4) Tag list  
EIP002_Data_
OUT 

WORD 
[8] 

→
(2)

 EIP002_Data
_OUT 

(16 
byte) 

 

 

 

■Input area (Controller ← X-SEL Controller) 
Controller setting 
(Set with Sysmac Studio) 

Tag data link parameter setting 
(Set with Network Configurator) 

Destination device 
information (EDS file 
setting contents) 

 
(1) 

 
Tag set: 
EIP002_IN 

16 byte 
(5) 

←
(3) 

Input_100-[16 
Byte] 

Global variable  (4) Tag list  
EIP002_Data_I
N 

WORD 
[8] 

→
(2)

 EIP002_Data
_IN 

(16 
byte) 
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Personal computer 

 

Global variable 

(CSV file) 

Destination 

device 

Controller 

 

10. Appendix 2 Setting the Tag Data Links Using the 

Software 
 

This section describes the procedure for setting the Controller without the configuration files 

(Procedure for setting parameters from the beginning).  

You can also refer to this section when you want to change the parameters of the 

configuration files.  

 

10.1. Overview of Setting Tag Data Links 

The following is the relationship between the processes to operate the tag data links using the 

"procedure for setting parameters from the beginning". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settings made with Sysmac Studio 
・Setting parameters (IP address, etc.)
・Setting global variables (name, 

network setting and task setting, 
etc.) 

・Exporting the Global Variables 
・Building 
・Settings in the Watch Tab Page 

Transferring 
the Project 
Data 

Installing EDS 
file 

Transferring the 
Tag Data Link 

EDS file 

Settings made with Network 
Configurator 

・Uploading network configuration 
・Importing CSV file (tag name) 
・Tag registration 
・Connection setting (associating 

tags with the EDS file of destination 
device) 

Network Configurator Sysmac Studio 
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10.2. Work Flow of "Procedure for Setting Parameters from the Beginning" 

Take the following steps to make the tag data link settings for EtherNet/IP using the 

"procedure for setting parameters from the beginning". 

This section describes the detailed procedures for 10.3. Setting Up the Controller Using the 

Software and 10.4. Setting Up the Network Using the Software (in red frames below). 

For 7.2. Setting Up the IAI X-SEL Controller and 7.5. Checking EtherNet/IP Communications, 

refer to the procedures in Section 7 as the same procedures for using the configuration files 

apply. 

 

 

7.2. Setting Up the IAI X-SEL Controller Set up the IAI X-SEL Controller. 

↓  
 7.2.1. Parameter Settings Set the parameters for the X-SEL Controller. 

↓  

10.3. Setting Up the Controller Using 

the Software 

Set up the Controller using the software.  

↓  
 10.3.1. Starting the Sysmac Studio and 

Setting the Parameters for the 

Controller. 

Start the Sysmac Studio and set the parameters for 
the Controller.  

↓  
 10.3.2. Setting the Global Variables  Set the global variables to use for the tag data links. 

↓  
 10.3.3. Exporting the Global Variables Export the global variables in a CSV file to use as 

tags in the Network Configurator.  
↓  

 10.3.4. Connecting Online and 

Transferring the Project Data 

Connect online with the Sysmac Studio and transfer 
the project data to the Controller.  

↓  
 10.3.5. Settings in the Watch Tab Page To check data that is sent and received, make 

settings in the Watch Tab Page.  
↓  
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10.4. Setting Up the Network Using the 

Software 

Set the tag data links for EtherNet/IP using the 
software.  

↓  
 10.4.1. Starting the Network 

Configurator and Installing the 

EDS File 

Start the Network Configurator and install the EDS 
file.  

↓  
 10.4.2. Connecting Online and 

Uploading Configuration 

Connect online with the Controller and upload the 
network configuration.  

↓  
 10.4.3. Importing the File and 

Registering the Tags 

Import the CSV file that was saved, and register tags 
of the originator's send area and receive area.  

↓  
 10.4.4. Setting the Connection Associate the tags of the target device with the tags 

of the originator. 
↓  

 10.4.5. Transferring the Tag Data Link 

Parameters 

Transfer the set tag data link parameters to the 
Controller.  

↓  

7.5. Checking EtherNet/IP 

Communications 

Confirm that the EtherNet/IP tag data links are 
performed normally. 

↓  
 7.5.1 Checking the Connection Status Check the connection status of EtherNet/IP.  

↓  
 7.5.2 Checking the Data that are Sent 

and Received 

Confirm that the correct data are sent and received. 
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10.3. Setting Up the Controller Using the Software 

Set up the Controller using the software.  

 

10.3.1. Starting the Sysmac Studio and Setting the Parameters for the 
Controller 
Start the Sysmac Studio and set the parameters for the Controller.  

Install the Sysmac Studio and USB driver in the personal computer beforehand.  

 

1 Connect the LAN cable and the 

USB cable to the Controller, and 

turn ON the power supply to the 

Controller.  

* For details, refer to step 1 of 

7.3.1. Starting the Sysmac 

Studio and Importing the 

Project File. 

 

 

2 Start the Sysmac Studio.  

Click the New Project Button.  

 

* If a confirmation dialog box for 

an access right is displayed at 

start, select to start.  

 

 

3 The Project Properties Dialog 
Box is displayed.  
 
* In this document, New Project 

is set as the project name.  
 
Confirm that Category and 
Device that you use are set in 
the Select Device Field.  
 
Select version 1.05 from the 
pull-down list of Version.  
 
* Although 1.05 is selected in 

this document, select the 
version you actually use.  
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4 Click the Create Button.  

5 The New Project is displayed.  

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

6 Double-click Built-in EtherNet/IP 

Port Settings under 

Configurations and Setup - 

Controller Setup in the Multiview 

Explorer.  

 

7 The Built-in EtherNet/IP Port 

Settings Tab Page is displayed 

in the Edit Pane.  

Click the TCP/IP Setting Button, 

select the Fixed Setting Check 

Box in the IP Address Field, and 

make the following settings.  

IP address: 192.168.250.1 

Subnet mask: 255.255.255.0 

 

 

Multiview 
Explorer 

Edit Pane Toolbox 
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10.3.2. Setting the Global Variables 
Set the global variables to use for the tag data links.  

 

1 Double-click Global Variables 

under Programming - Data in 

the Multiview Explorer.  

 

2 The Global Variables Tab Page 

is displayed in the Edit Pane.  

Click a column under the Name 

Column to enter a new variable. 

 

Enter EIP002_Data_OUT in the 

Name Column. 

 

Enter WORD[8] in the Data Type 

Column. 

* After entering, it changes to 

ARRAY[0..7] OF WORD as 

shown in the right figure.   

 

Select Output from the Network 

Publish Menu.  

 

 

 

 

 

 

 

3 After entering, right-click and 

select Create New from the 

menu.  
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4 Enter the following data in the 
new columns in the same way 
as steps 2 and 3. 
・Name: EIP002_Data_IN  

Data Type: WORD[8] 
Network Publish: Input 

 

 

5 Double-click Task Settings 

under Configurations and Setup 

in the Multiview Explorer.  

The Task Settings Tab Page is 

displayed in the Edit Pane. Click 

the Settings for Exclusive 

Control Variables in Tasks 

Button.  

Click the + Button.  

6 Click the Down Arrow Button of 

the Variable to be refreshed. 

The variables set in step 2 to 5 

are displayed. 

Select EIP002_Data_OUT.   

7 Click the + Button and select a 

variable to be refreshed.  

* The data types are displayed 

automatically, and you do not 

have to set them.  

 

Add the variable set in step 4 as 

shown in the right figure. 
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10.3.3. Exporting the Global Variables 
Export the global variables in a CSV file to use as tags in the Network Configurator.  

 

1 Double-click Global Variables 

under Programming - Data in 

the Multiview Explorer.  

 

2 The Global Variables Tab Page 

is displayed in the Edit Pane.  

Right-click on the pane and 

Select Select All.  

 

 

All the selected variables are 

highlighted.  

 

3 Select Export Global Variables 

- Network Configurator from 

the Tools Menu.  

4 The Save As Dialog Box is 

displayed. Enter EIP002 in the 

File name Field.  

Click the Save Button.  
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10.3.4. Connecting Online and Transferring the Project Data 
Connect online with the Sysmac Studio and transfer the project data to the Controller.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed 

in the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

 

3 Select Rebuild Controller from 
the Project Menu.  

 

4 A confirmation dialog box is 

displayed. Check the contents 

and click the Yes Button.  

5 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  

6 Select Communications Setup 

from the Controller Menu.  
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7 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option for Connection 

Type.  

 

Click the OK Button.  

8 Select Online from the 

Controller Menu.  

A confirmation dialog box is 

displayed. Click the Yes Button.

 

* The displayed dialog box 

depends on the status of the 

Controller used. Check the 

contents and click the Yes 

Button to proceed with the 

processing.  

 
 

9 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  
 

Additional Information  

For details on online connections to a Controller, refer to Section 5 Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

10 Select Synchronization from 

the Controller Menu.  
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11 The Synchronization Dialog Box 

is displayed.  

Confirm that the data to transfer 

(NJ501 in the right dialog box) is 

selected. Then, click the 

Transfer To Controller Button. 

 

* After executing the Transfer To 

Controller, the Sysmac Studio 

data is transferred to the 

Controller and the data are 

compared.  

 

 

12 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

 

 

A screen stating "Synchronizing" 

is displayed.  

 

 

A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the No 

Button.  

* Be sure not to return it to "RUN 

mode".  
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13 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized" 

and that a message is displayed 

stating "The synchronization 

process successfully finished" 

If there is no problem, click the 

Close Button.  

 

* A message stating "The 

synchronization process 

successfully finished" is 

displayed if the Sysmac Studio 

project data and the data in 

the Controller match.  

 

* If the synchronization fails, 

check the wiring and repeat from 

step 1.  

 

 



10．Appendix 2 Setting the Tag Data Links Using the Software 

 53

 

10.3.5. Settings in the Watch Tab Page 
To check data that is sent and received, make settings in the Watch Tab Page.  

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch1 Tab Page is displayed 

in the lower section of the Edit 

Pane.  

3 Enter the following names in the 

Watch1 Tab Page for monitoring. To 

enter a new name, click a column 

stating Input Name.  

EIP002_Data_OUT[0] 

EIP002_Data_OUT[1] 

EIP002_Data_OUT[2] 

EIP002_Data_IN[0] 

EIP002_Data_IN[1] 

EIP002_Data_IN[2] 
 
 
* You will use the settings in 7.5.2. 

Checking the Data That are Sent 
and Received.  
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10.4. Setting Up the Network Using the Software 

Set the tag data links for EtherNet/IP using the software.  

 

10.4.1. Starting the Network Configurator and Installing the EDS File 
Start the Network Configurator and install the EDS file.  

 

1 Start the Network 

Configurator.  

2 Select Install from the EDS File 

Menu. 

 

3 Select the 

368-9523-EDS_ABCC_EIP_V_

2_2.eds as an EDS file to install 

and click the Open Button. 

 

* For how to obtain the EDS file, 

refer to Precautions for 

Correct Use in 5.2. Device 

Configuration.  

 

Network window 
Hardware 
List 
Window 
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4 The dialog box on the right is 

displayed. Check the contents 

and click the No Button.  

 

5 When the EDS file is normally 

installed, the device is added as 

shown in the right figure.  

Confirm that the device was 

added to the EtherNet/IP 

Hardware List.  

 

* When installing the 

368-9523-EDS_ABCC_EIP_V

_2_2.eds file, the Anybus-CC 

EtherNet/IP device is 

registered. 

 

 

 

 

 

Precautions for Correct Use  

Please confirm that the LAN cable is connected before performing the following procedure.  

When it is not connected, turn OFF the power supply to each device and then connect the 

LAN cable.  
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10.4.2. Connecting Online and Uploading Configuration 
Connect online with the Controller and upload the network configuration.  

 

1 Select Select Interface - NJ 

Series USB Port from the 

Option Menu.  

2 Select Connect from the 

Network Menu.  

 

3 The Select Connect Network 

Port Dialog Box is displayed. 

Select TCP:2 . 

Click the OK Button.  

4 The Select Connected Network 

Dialog Box is displayed. Check 

the contents and click the OK 

Button. 
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5 When an online connection is 

established normally, the color 

of the icon on the right figure 

changes to blue.  

 

 

Additional Information  
If an online connection cannot be made to the Controller, check the cable connection. Or, 

return to step 1, check the settings and repeat each step.  

For details, refer to 7-2-8 Connecting the Network Configurator to the Network in Section 7 

Tag Data Link Functions of the NJ-series CPU Unit Built-in EtherNet/IPTM Port User's Manual 

(Cat. No. W506). 

 

6 Select Upload from the Network 

Menu to upload the device 

information on the network.  

 

7 The dialog box on the right is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  
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8 The Target Device Dialog Box is 

displayed.  

Select the192.168.250.1 

Checkbox and the 

192.168.250.2 Checkbox, and 

click the OK Button.  

 

* If 192.168.250.1 or 

192.168.250.2 is not 

displayed on the dialog box, 

click the Add Button to add the 

address.  

 

* The displayed addresses 

depend on the status of the 

Network Configurator.  

 

 

9 The device parameters are 

uploaded. When uploading is 

completed, the dialog box on the 

right is displayed.  

Check the contents and click the 

OK Button.  

 

10 After uploading is completed, 

confirm that the Network 

Configuration Pane shows the 

updated IP addresses of the 

devices.  

IP address of node 1: 

192.168.250.1 

IP address of node 2: 

192.168.250.2 

 

* The X-SEL Controller icon 

changes to the Anybus-CC 

EtherNet/IP device. 
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11 Right-click the node 2 device 

and select Parameter - Edit.  

12 The Edit Device Parameters 

Dialog Box is displayed.  

Enter the following values and 

click the OK Button.  

・Output Size: 16 

・Input Size: 16 
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10.4.3. Importing the File and Registering the Tags 
Import the CSV file that was saved, and register tags of the originator's send area and 

receive area.  

This section explains the receive settings and then send settings of the target node.  

 

1 On the Network Configuration 

Pane of the Network 

Configurator, right-click the node 

1 device and select Parameter - 

Edit.  

2 The Edit Device Parameters 

Dialog Box is displayed.  

Click the To/From File Button.  

3 Select Import from File.  

 

4 The Import Connection 

Configuration Dialog Box is 

displayed. Select EIP002.csv 

and click the Open Button. 

 

* In the Look in Field, specify the 

folder in which the file was 

saved in Section 10.3.3 

Exporting the Global 

Variables.  
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5 The right dialog boxes may not 

be displayed depending on the 

status of the Controller and 

software used. In such a case, 

proceed to the next step. 

 

The right dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 

 

The right dialog box is 

displayed. Confirm that there is 

no problem and click the No 

Button. Make sure that tag sets 

are not created automatically.  

 
 

 

6 The Edit Tags Dialog Box is 

displayed again.  

Click the Tag Sets Tab.  

7 The data on the Tag Sets Tab is 

displayed. Select the 

In-Consume Tab and click the 

Edit Tags.  

Here, register an area (node 2 

→ node 1) where node 1 

consumes data.  
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8 The Edit Tags Dialog Box is 

displayed. 

Select the In - Consume Tab.  

The tab page shows the variable 

name that was set in 10.3.2 

Setting the Global Variables and 

that is listed in 9.2. Relationship 

between Destination Device and 

Global Variables.   

 

9 Select the Out-Produce Tab.  

In the same way as the previous 

step, the tab page shows the 

variable name that was set in 

10.3.2 Setting the Global 

Variables and that is listed in 

Section 9.2. Relationship 

between Destination Device and 

Global Variables.  

 

Click the OK Button.  

 



10．Appendix 2 Setting the Tag Data Links Using the Software 

 63

10 The Edit Device Parameters 

Dialog Box is displayed again.  

Click the New Button.  

11 The Edit Tag Set Dialog Box is 

displayed.  

Select EIP002_Data_IN from 

the Candidate Tag List and click 

the << Button.  
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12 Enter EIP002_IN in the Name 

Field.  

 

Click the Regist Button.  

13 The Edit Tag Set Dialog Box is 

displayed. Click the Close 

Button. 

 

14 The Edit Tags Dialog Box is 

displayed again.  

EIP002_IN and 16 Byte are 

displayed. 

15 Select the Out-Produce Tab.  

Click the New Button.  
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16 The Edit Tag Set Dialog Box is 

displayed. 

Move the variable from the 

Candidate Tag List to the Tag 

List in the same way as steps 

11. 

 

 

Enter EIP002_OUT in the Name 

Field.  

 

Click the Regist Button.  

 

17 The Edit Tag Set Dialog Box is 

displayed. Click the Close 

Button.  

 

18 The Edit Device Parameters 

Dialog Box is displayed again.  

EIP002_OUT and 16 Byte are 

displayed.  

Select the Connections Tab 

Page. 
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10.4.4. Setting the Connection 
Associate the tags of the target device (that receives the open request) with the tags of the 

originator (that requests opening).  

 

1 Select 192.168.250.2 in the 

Unregister Device List Field. 

Click the Down Arrow Button 

that is shown in the dialog box. 

2 192.168.250.2 is registered in 

the Register Device List.  

Select 192.168.250.2 and click 

the New Button.  

3 The Edit Connection Dialog Box 

is displayed. Select Exclusive 

Owner from the Connection I/O 

Type pull-down list.  

Set the values listed in the table 

below for Originator Device and 

Target Device.  

 

■Settings of connection 

Connection allocation Setting value 

Connection I/O type Exclusive Owner 

Input Tag Set EIP002_IN-[16 Byte] 

Connection Type Multi-cast connection 

Output Tag Set EIP002_OUT-[16 Byte] 

Originator device 

Connection Type Point to Point connection 

Output Tag Set Input_100-[16 Byte] Target Device 

Input Tag Set Output_150-[16 Byte] 
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4 Confirm that the settings are 

correct and click the Regist 

Button.  

5 The Edit Connection Dialog Box 

is displayed again. Click the 

Close Button.  

6 The Edit Device Parameters 

Dialog Box is displayed again. 

Click the OK Button.  

7 When the connection is 

completely allocated, the 

registration destination node 

address is displayed under the 

device icon of the destination 

device on the Network 

Configuration Pane.  

 

* The X-SEL Controller Icon 

changes to the Anybus-CC 

EtherNet/IP device. 
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10.4.5. Transferring the Tag Data Link Parameters 
Transfer the set tag data link parameters to the Controller.  

 

1 Right-click node 1 device on the 

Network Configuration Pane and 

select Parameter - Download. 

 

 

 

 

The dialog box on the right is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

 

2 Tag data link parameters are 

downloaded from the Network 

Configurator to the Controller.  

 

3 The dialog box on the right is 

displayed. Check the contents 

and click the OK Button.  
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11. Revision History 
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code 
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